SILICON LABS

Control Zigbhee Device with MQTT Worksheet

In this worksheet we provide a step-by-step guide to create, build
and run Z3GatewayHost and NCP sample based on EmberZNet
Stack 6.6.4. If you use a later release in the future, most of the
instructions should still apply, although there could be minor
differences not foreseen at the time of this document.

These exercises help you get familiar with ZigBee 3.0 in the EmberZNet Stack, Simplicity
Studio v4 development environment, and the Wireless Start Kit (WSTK) with EFR32MG
modules. We assume that you have a WSTK and the following software requirements:

=  Simplicity Studio 4

= EmberZNet 6.6.4

= GCC7.2
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1 Pre-requisites

Make sure you have installed the EmberZnet 6.6.4 SDK and GCC toolchain on your PC.
1.1 Check EmberZnet SDK
1. Launch Simplicity Studio v4.
2. “Windows”->"Preference”>"Simplicity Studio”>"SDKs”, make sure “EmberZnet 6.6.4” is installed

=1 Preferences X
type filter text 5DKs (=R v v
g;gf’j‘ Check the SDKs available for project build configurations.
Help Checked entries are displayed when configuring projects.
Install/Update -
Network Analyzer Name Version Location Select Al
Run/Debug (] Bluetooth SDK Lite 220 CiiliconLabsSimpli p blelite\v2.2.0.0\ T
 Simplicity Studio [ Gecko SDK Suite: Bluetooth 2.10.1.0, EmberZNet 6.4.1.0, Flex 2.4.1.0, MCU 5.6.1.0, Micrium OS Kernel, Thread 2.8.0.0 241 Casiliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suitew2.4\ clect None
Adapter Packs [ Gecko SDK Suite: Bluetooth 2.11.5.0, EmberZNet 6.5.5.0, Flex 2.5.5.0, MCU 5.73.0, Micrium OS Kernel 5.6.0, Thread 29.5.0 255 Casiliconabs\SimplicityStudio\v4\develope\sdks\gecko_sdk_suitew2.5\
Crypto Profiles Gecko SDK Suite: Bluetooth 2.12.4.0[EmberZNet 6.6.4.0]Flex 2640, MCU 5.8.40, Micrium OS Kerel 5.7.0, Thread 2.10.40 264 CaSiliconLabs\SimplicityStudic\v4\developensdks\gecko_sdk_suite\v2.61
Device Filtering [ Gecko SDK Suite: Bluetooth 2.8.1.0, EmberZNet 6.2.3.0, Flex 2.2.2.1, Kernel, MCU 5.4.0.0, Micrium, OS, Thread 2.6.2.0 222 Co\siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suitew2.2\, Add
Device Manager [ Gecko SDK Suite: Bluetooth 2.9.2.0, EmberZNet 6.3.1.0, Flex 2.3.1.0, Kernel, MCU 5.5.1.0, Micrium, OS, Thread 27.1.0 221 Co\Siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suite\w2.3\ —
Energy Profiler [] Gecko SDK Suite: EmberZNet 5,10.20, MCU 5220 1 Ca\siliconLabs\SimplicityStudio\v4\developersdks\gecko_sdk suite\wl. T\ =
Launcher [ Gecko SDK Suite: EmberZNet 59.2.0, MCU 5.1.3.0 101 Ci\Siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk suite\1.0\
Offline Content [ Gecko SDK Suite: EmberZNet 6:0.3.0, Flex 20, 202 Ci\Siliconlabs\SimplicityStudio\v4\developersdks\gecko_sdk_suiteWw2.01
Preferred IDE [ Gecko SDK Suite: EmberZNet 6.1.0.0, MCU 53.50, Micrium 05 Kernel 5.20 210 C:\SiliconLabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suiteWw2.T
SDKs [] Stackless applications 100 (none)
Systemuien
Tergets
Toolchains
User Experience
Wine location
Team
Wireless Development
Description: More details

Select an entry to see a description

Need more $DKs? Customize your installation here...
©) o
Figure 1 Check SDK in Simplicity Studio

1.2 Check Toolchains
1. Launch Simplicity Studio v4.
2. “Windows”->"Preference”->"Simplicity Studio”->"Toolchains”, make sure GCC toolchain is installed.
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=+ Preferences

x
type fifter text Toolchains

o
> g;g“‘ Manage the toolchains available for MCU project build configurations.
> C/Ces

> Help
> Install/Update
» Network Analyzer Name Location Version Select All
> Run/Debug GNU ARM v7.2.1 CasiliconL. P _em'7.2 2017qd\ 7.2.1.20170904
~ Simplicity Studio AR ARM CiProgram Files (26]\ /AR Systems\Embedded Workbench 831 EEFiF)
> Adapter Packs
Crypto Profiles
Device Filtering Add..
> DeviceManager —
Energy Profiler
Launcher
Offline Content
Preferred IDE
SDKs
SystemView
Targets
Toolchains
User Experience
Wine location
> Team
> Wireless Development

Each checked entry in this list will be a candidate for automatically generating the build configurations in MCU projects,

Select None

Description:

More details
Select an entry to see a description

Need more toolchains? Customize your installation here.
@ Cancel
Figure 2 Check Toolchain in Simplicity Studio

1.3 Install the software tools:
1. Cygwin;

Extract the package cygwinx86.rar and copy it to the root directory of disk C.

You can also extract the package cygwinx86.rar to other location as long as there is only ASCII characters in the path. In this case you
will need to modify the file “cygwin_here.reg” and modify the path according to your location.

Windows Registry Editor Version 5.00

[HKEY CLASSES ROOT\Folder\shell\open cygwin]
@="Open Cygwin Here"

[HKEY CLASSES ROOT\Folder\shell\open cygwin\command]
@="C:\\cygwinx86\\bin\\mintty.exe /bin/sh -1lc 'cd \" cygpath \"%V\" '\"; bash'"

[HKEY CLASSES ROOT\Directory\Background\shell\open cygwin]
@="Open Cygwin Here"

[HKEY CLASSES ROOT\Directory\Background\shell\open cygwin\command]

@="C:\\cygwinx86\\bin\\mintty.exe /bin/sh -1lc 'cd \" cygpath \"$V\" \"; bash'"

Double click “cygwin_here.reg” then select a folder and right click, check if there is a menu to start Cygwin in this folder.
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Expand

Open in new window

Eﬂpen Cygwin Here j

Pin to Quick access

Open in Visual Studio

Git GUI Here

Git Bash Here

dos here

powershell_here

7-Zip >
CRC SHA >

Figure 3 Right-click menu to start cygwin

2. MQTT broker;
Install mosquitto-1.6.7-install-windows-x64.exe, then press “Win+R” and input “services.msc” to start the service manager.

Find “Mosquitto Broker”, and make sure it's in “running” status. (If it's not running, select it and right click then select start)

EIVITCI S L VTNV S IV WU STV IS, PPULES IS0 (LA E- TR LN - T RV P

LULal Fy LS,
L]

Mozsquitto Broker MOTT v3.1.... Running Automatic Local Syste...
l.,'.";:!_;l‘-:'lnzilla Maintenance Service The Mozilla ... Manual Local Syste...
E:J_;Natural Authentication Stop Enables frict.., Manual Local Syste..,
E;?;Net.Tcp Port Sharing Service Pause Provides abi... Disabled Local Service
'»,'.’;:J_;Netlagan Resume Maintains a... Running  Automatic Local Syste..,
E;?;Netuvnrk Connected Devices Auto-5Setup Rectart Metwork Co... Manual (Trig... Local Service
'»,'.’;:J_;Netwurk Connection Broker Brokers con.. Running  Manual (Trig..  Local Syste..,
i€). Network Connections All Tasks » Manages o... Manual Local Syste...

i 9 il
Q'J:J_;Nehnmrk Connectivity Assistant Refresh Provides Dir... Manual (Trig... Local Syste...
1€ Metwork List Service Identifies th... Runnin Manual Local Service

i 9
{2k Metwork Location Awareness Properties Collects an...  Runnin Automatic Metwork 5...

3 g
'E-:J;Netwnrk Setup Service Hel The Metwor... Manual (Trig...  Lecal Syste..,

o =
Ll Metwork Store Interface Service g This service ...  Runnin Autocmatic Local Service

3 g

E"‘l Kl A mmlimadimm Wl ©amemre Tl Kl Al Dhimmim e B b ki I mmal Coardm

Figure 4 Check and start MQTT broker
3. MQTT client

Install MQTTBox-win.exe.

1.4 How to flash the program
1. Start Simplicity Studio, then connect your device to PC;
ELIE
2. Inthe menu bar, find the icon ' for “Flash Programmer”, press it;
3. In the popup window, select the device;
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e ot

Select a device to program

e J-Link Silicon Labs (440088231) : EFR32MG1P132F256GM48
TSNP e )-Link Silicon Labs (440123943) : EFR32ZMG12P433F1024GL125

O |
b

Select Device

Flash Part
File

I:EFFDWSE...

Advanced Se

Erugram
] Rernember my decision

QK Cancel

® Cloze

Figure 5 Select device

4. Then in the next window, click “browse” to select the generated image ( .s37 or .hex) of your project, press “Program”. You can
also press “erase” if needed. Normally you just need to erase the device once before when you start the hands-on. The gener-
ated image is in the binary folder of your project. You can select it in “Project Explorer”.
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v 135 Z3LightSoc [GNU ARM v7.2,1 - Default] [EFR32MG12P332 E——
W q;;"' Binaries + Application co
> % Z3lightSec.axf - [arm/le]

Generation direc
» 2 Z3LightSoc.bin - [unknown/le]

s> (2 Z3lightSec.gbl - [unknown/le] Select architec
by F3lightSoc.hex - [unknown/|g] . Board: EFRZ
> 2 zz.Lights.:u:.sa?-[unh;r—---—"gv e
> [ait Includes ™ .
¥ = adc Open
» [ @es-cmac )
?
» = antenna-stub Open With
> [= basic Copy Ctrl+C
= ccmjencr}fptlon Pacte Cirl+V
» [ coexistence-stub
Delete Delete
» = color-control-server
» = counters Move...
» [= debug-basic-library Rename... F2
» [= debug-jtag
s = efri2 ST g
» = ember-minimal-printf 2 Refresh E5
s = emdrv
v = emlib Run As -]
> 22 edernal-generated-files Debug As ¥
. > [ find-and-bind-target Profile As 5
Bt = Team >
Debug Adapters &2 | o= Cutline Compare With g
= =
h R T (A X Replace With H

Y J-Link Silicon Labs (44012851¢
Browse Files Here

@ Open Command Line Here
[ Flash to Device.. ]

Properties Alt+Enter

Figure 6 Select image
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= Flash Programmer O *
e
Device

Board Marme; Wireless Starter Kit Mainboard

Board Mame: EFR32MG12 2400915 MHz 19 dBrm Dual Band Radio Board

MCU Mame: EFR32MG12P433F1024GL125

Adapter
Mame: I-Link Silicon Labs (440123943)

Flash Part

File Type ®hex Obin  Base address 00

File Please enter a valid path

| =
Advanced Settings...
Flash Erase/Write Protection

elect flash range W A = v | Ox100000 Y
®select s ang

() Select default sections Lock Main Flash Lock User Page

Protect Remove Protection

Debug Lock Tools

The unleck function only works using Silicon Labs EFM32 and EFR32 boards.
Unlocking the chip will erase all data on flash and SRAM.

Unlock Debug Access | | Lock Debug Access

?\ Close
Figure 7 Flash application

1.5 How to open console

Simplicity Studio has integrated a console so that it's convenient to debug through console. To use the console, you need:

1} Simplicity IDE
1. Change to “Simplicity IDE” perspective

2. Select your adapter in the “Debug Adapters” window, right click and select ‘connect”;
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3. Select your adapter in the “Debug Adapters” window, right click and select “Launch console”;
# Debug Adapters :° 5= Outline ‘ = B
PAEARRKUBI-EEEH

J-Link Silicon Labs (44017012
Rename

Disconnect

Start capture

Start capture with options..
Stop capture

Redo last upload

Upload application..
Upload adapter firmware...

Make a sniffer

I Sniffer Configurator..

Eaunch Console.. j

38 Device configuration..

| Force Unlock..

=) Open SWO Terminal...

- -

Figure 8 Launch console

1.6 How to start Capture

1 Simplicity IDE

1. Change to “Simplicity IDE” perspective :
2. Select your adapter in the “Debug Adapters” window, right click and select “connect”;
3. Select your adapter in the “Debug Adapters” window, right click and select “Start Capture”;
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¥ Debug Adapters ©7 5= Outline | = B

X AXBESG-EE2E R

J-Link Silicon Labs (4401ec1&
Rename

Disconnect

Start capture with options..
Stop capture

Redo last upload

Upload application..
Upload adapter firmware...

Make a sniffer

I Sniffer Configurator..

Launch Console...

38 Device configuration...

,  Force Unlock...

=1 Open SWO Terminal..

Figure 9 Start Capture

2 Build the bootloader

Go to File -> New -> Project. This will bring up the New Project Wizard
Select “Silicon Labs AppBuilder Project”. Click Next.

Select “Gecko Bootloader”. Click Next.

Select the latest version. (Gecko Bootloader 1.9.2). Click Next.

Select “UART XMODEM Bootloader”. Click Next.

Name your project (Whatever name you want). Click Next.

Select board and compiler. Then finish.

Noookrowh =
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O x
Project setup ——

-c':"y
X

Select the board, part, and initial build configurations.

Boards:

Search | W

EFR32MG12 2.4GHz 10 dBm (BRD4162A Rev ADT) *

Part:
| Search | W
| EFR32MG12P332F1024GL125 |
Check the configurations to include in the project
v GMU ARM v4.9.3 E Select All i
Diefault
Select Mone

Diefault

Manage toolchains...

Manage build targets...

Figure 10 Select board and compiler

8. The new project should have been created now, with the project configuration file (an .isc file) open.

9. Click “Generate”. Notice the project files appearing in Project Explorer. A window saying Generation successful will appear.
Click OK.
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10. Select the project in Project Explorer window and compile your project by clicking on the Build icon % . Ensure that the build
completes with O errors.

3 Build the NCP image

Go to File -> New -> Project. This will bring up the New Project Wizard

Select “Silicon Labs AppBuilder Project”. Click Next.

Select “Customizable network coprocessor (NCP) Applications”. Click Next.

Select “NCP UART HW (Hardware Flow Control)”. Click Next.

Name your project, such as “ncp”. Click Next.

In next window (Project Setup), select board to BRD4162A, and compiler to “GCC v7.2” (If you don’t have it, please install any
other). Click Finish.

o0 kwh=
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we O pos
Project setup —

Select the board, part, and initial build configurations.

Boards:

Search | W

EFR32MG12 2.4GHz 10 dBm (BRD4162A Rev ADT) *

Part:
| Search | W

| EFR32MG12P332F1024GL125 |

Check the configurations to include in the project

v [7] GNU ARM v4.9.3 [ SelectAll |
Diefault

Select Mone

Diefault

Manage toolchains...

Manage build targets...

Figure 11 select board and compiler

7. Click “Generate”. Notice the project files appearing in Project Explorer. A window saying “generating successfully” will appear.
Click OK.

8. Select the project in Project Explorer window and compile your project by clicking on the Build icon % . Ensure that the build
completes with O errors.
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4 Build the host program

Go to File -> New -> Project. This will bring up the New Project Wizard

Select “Silicon Labs AppBuilder Project”. Click Next.

Select “Silicon Labs Zigbee”. Click Next.

Select our latest EmberZNet stack for host (in this case EmberZNet 6.6.4 GA Host). Click Next.
Select “Z3Gateway”. Click Next.

Name your project, such as “Z3GatewayHost”. Click Next.

In next window (Project Setup), leave the “Boards” and “Parts” field empty, then finish.

e | >

Nookowh=

Project setup <>

(i) Mo valid toolchains available. You will not be able to use Simplicity IDE with
this project.

Boards:

Search j | W

Part:

ES_Earn:h _] | W

| Mone |

Check the configurations to include in the project

e

w (Mo toolchain) (w0.0.0) I Select All

None Toolchain Configuration (active)

—

e

Select Mone

Set Active

Manage toclchains...

Manage build targets...

@ x>

Figure 12 select board and compiler

8. You need to select the following plugins. You can input the name in the filter to navigate to the plugins quickly.
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& General [ ZCL Clusters | Zigbee Stack | Printingand CLI (@ HAL (<> Plugins S Callbacks | &% In

Plugin configuration

Use this section to select or unselect the plugins that you want to use in your application

Eatma}r J

~ [m] 2 Unix Host
[ ]== Gateway Relay Coap
[]== Gateway Relay Mqtt
[] == Gateway Support, provides AP|: gateway
v [ % Utility
[ 1= Gateway MOTT Transport, provides APl transport-magtt

4k

Figure 13 use filter to navigate the plugins

Gateway MQTT Transport
Paho MQTT
CJSON
Gateway Support
Device-Table
Command Relay
g. Gateway Relay MQTT
9. Use “Ctrl+S” to save, then click “Generate”. Notice the project files appearing in Project Explorer. A window saying “generating
successfully” will appear. Click OK.

~ooo0oTp

10. If you have a right-click menu to start Cygwin, then just change to the host project directory and then right click to start Cygwin
here. Otherwise, change to Cygwin you extracted, run “Cygwin.bat” to start Cygwin. Change to the project folder and run com-
mand “make”. You can find the project directory in “General” tab:

‘& General oY ZCL Clusters | % ZigbeeStack | &% Printingand CLI | @ HAL | <> Plugins | & Callbacks | &% Includes | &% Oth

= Application configuration

Generation directory: | Relative to I15C file I ChUsersh, 'xDu:ucuments\ZMGCZﬂ19ﬁﬁﬁatmayHuﬂJ | =

Select architecture for this application:
. Board: Custom
g Part: pc

% Toolchain: N/A

Edit Architecture

Device name: | Z3GatewayHost

Figure 14 find project directory

Pay attention that you need to replace the windows partition string to Cygwin format. (If you have a right-click menu to start
Cygwin, you can directly change to the host project directory and the right click to start cgywin)

e.g:

//Windows path: C:\SiliconLabs\SimplicityStudio
cd /cygdrive/c/SiliconLabs/SimplicityStudio

silabs.com | Smart. Connected. Energy-friendly Rev.1.0 | 13




Control Zigbee Device with MQTT Hands-on Guide

11. Wait until the build finished. If there is no error, there would be a program “Z3GatewayHost.exe” generated in
“build\exe” under your project folder.
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5 Test

1. Flash the bootloader (xxx-combined.s37) and ncp (ncp.s37) image to WSTK (NCP);

2. Flash the provided bootloader (bootloader-storage-internal-single-combined-Z3light.s37) and Z3Light (Z3LightSoc.s37) sample to
your light.

3. Find the COM port number of your NCP board. You can just connect the WSTK for NCP and unplug all other WSTKs, then check
the COM port number in “Device Manager” on your PC.

4. Make sure your WSTK for NCP is disconnected in Simplicity Studio.

5. Start Cygwin, and switch to the directory of the Z3GatewayHost project, then switch to “build/exe” directory. Run the following
command to start the host:

//COM17 is the COM port of the NCP
./Z3GatewayHost.exe -p COM17

- Documents/v4_workspace_2. 3GatewayHost

$ cd build/exe/

_ /cygdrive/c/Users - /Documents/v4_workspace_2.6/Z3GatewayHost/build/exe

$ ./Z3GatewayHost.exe -p COM1l7
Reset info: 11 (SOFTWARE)
ezsp ver 0x07 stack type 0x02 stack ver. [6.6.4 GA build 180]
Ezsp Config: set source route table size to 0x0064:Success: set
Ezsp Config: set security level to 0x0005:Success: set
Ezsp Config: set address table size to 0x0002:Success: set
Ezsp Config: set TC addr cache to 0x0002:Success: set
Ezsp Config: set stack profile to 0x0002:Success: set
Config: set MAC indirect TX timeout to Ox1EO00:Success: set
Config: set max hops to OxO00lE:Success: set
config: set tx power mode to Ox8000:Success: set
Config: set supported networks to Ox0001l:Success: set
value : set end device keep alive support mode to 0x00000003:Success: set
Policy: set binding modify to "allow for valid endpoints & clusters only":Success: set
Policy: set message content in msgSent to "return":Success: set
value : set maximum incoming transfer size to 0x00000052:Success: set
value : set maximum outgoing transfer size to O0x00000052:Success: set
Config: set binding table size to 0x0010:Success: set
config: set key table size to 0x0040:Success: set
Config: set max end device children to 0x0020:Success: set
Config: set aps unicast message count to Ox000A:Success: set
config: set broadcast table size to Ox000F:Success: set
Config: set neighbor table size to 0x0010:Success: set
NCP supports maxing out packet buffers
config: set packet buffers to 179
Config: set end device poll timeout to O0x000l:Success: set
config: set z11 group addresses to Ox0000:Success: set
config: set z11 rssi threshold to OxFFD8:Success: set
Config: set transient key timeout to Ox00B4:Success: set
Endpoint 1 added, profile 0x0104, in clusters: 8, out clusters 20
Endpoint 242 added, profile OxAlEQ, in clusters: 0, out clusters 1
Client Init

Figure 15 Start host

Wait until you see the following message. The host program should be able to connect to the MQTT broker in a few seconds.

MQTT connected to broker

MQOTT connected, starting gateway heartbeat and command processing
Subscribing to topic "gw/90FDI9FFFFE7B81BD/commands"” using QoS2
Subscribing to topic "gw/90FD9FFFFE7B81BD/publishstate”™ using QoS2
Subscribing to topic "gw/90FDI9FFFFE7B81BD/updatesettings" using QoS2

6. Start MQTT client (MQTTBox).
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Create MQTT Client

a. Press button “Create MQTT Client” to create a new client.
b. Fill the “MQTT Client Name”, “Protocol” and “Host” field, and leave the other fields as is. After that, press “save”.

51 MQTT30x - o X
MQTTBox Edit Help
SMenu 4 MQTTCLIENTSETTINGS OCIRgtEatingelisl
MQTT Client Name MQTT Client id Append timestamp to MQTT client id? Broker is MQTT v3.1.1 compliant?
2019ZMGC b7817151-4fBb-417b-8e74-83302batal54 o @ Yes ¥ Yes
Protocol Host Clean Session? Auto connect on app launch?
magtt / tep v localhost/ 1883 ¥ Yes ¥ Yes
Username Password Reschedule Pings? Queue outgoing QoS zero messages?
Usermname Password @ Yes ¥ Yes
Reconnect Period (milliseconds) Connect Timeout (milliseconds) KeepAlive (seconds)
1000 30000 10
Will - Topic Will - QoS Will - Retain Will - Payload
Will - Topic 0 - Almost Once A No

Figure 16 create mqtt client

7. Subscribe the following topic to monitor the device status change.

gw/<eui6d id>/devicejoined
gw/<eui64 id>/deviceleft

You need to replace the field <eui64_id> to the real Eui64 of your NCP. You can run “info” command in the host console to get
that.

Z3GatewayHost>info

MFG String:

AppBuilder MFG Code: 0x1002

node [ (>) 000B57FFFEA8EF3C] chan [0] pwr [-1]

panID [OxFFFF] nodeID [OxFFFE] xpan [0x(>)0000000000000000]

ezsp ver 0x07 stack type 0x02 stack ver. [6.6.4 GA build 180]

nodeType [0x04]

Security level [05]

network state [00] Buffs: 59 / 72

Ep cnt: 2

ep 1 [endpoint enabled, device enabled] nwk [0] profile [0x0104] devId [0x0007] ver [0x01]
out (client) cluster: 0x0000 (Basic)

in (server) cluster: 0x0000 (Basic)

out (client) cluster: 0x0003 (Identify)

in (server) cluster: 0x0003 (Identify)

out (client) cluster: 0x0004 (Groups)

out (client) cluster: 0x0005 (Scenes)

out (client) cluster: 0x0006 (On/off)

in (server) cluster: 0x0006 (On/off)

out (client) cluster: 0x0008 (Level Control)
in (server) cluster: 0x0008 (Level Control)
i

)
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
n (server) cluster: 0x000A (Time)
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (
( ) (

in (server) cluster: 0x0019 (Over the Air Bootloading)

in (server) cluster: 0x001lA (Power Profile)

out (client) cluster: 0x0020 (Poll Control)

out (client) cluster: 0x0300 (Color Control)

in (server) cluster: 0x0300 (Color Control)

out (client) cluster: 0x0400 (Illuminance Measurement)

out (client) cluster: 0x0402 (Temperature Measurement)

out (client) cluster: 0x0405 (Relative Humidity Measurement)
out (client) cluster: 0x0406 (Occupancy Sensing)
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out (client) cluster: 0xFC02 (MFGLIB Cluster)
ep 242 [endpoint enabled, device enabled] nwk [0] profile [0xAlEQ] devId [0x0061] ver [0x01]
out (client) cluster: 0x0021 (Green Power)
Nwk cnt: 1
nwk O [Primary (pro)]
nodeType [0x01]
securityProfile [0x05]

out (client) cluster: 0x0500 (IAS Zone)
out (client) cluster: 0x0702 (Simple Metering)
out (client) cluster: 0x0B01l (Meter Identification)
out (client) cluster: 0x0OB0O3 (Appliance Statistics)
out (client) cluster: 0x0B04 (Electrical Measurement)
out (client) cluster: 0xFCOl (Configuration Cluster)
( (
[
(

Topic to subscribe

gw/90FD9FFFFE7B81BD/devicejoined|

QoS

0 - Almost Once v

Figure 17 subscribe MQTT topic

8. Publish the following topic to Z3GatewayHost, so that the input command can be run on the host.
a. Create a network with the following command

Topic: (You need to replace the red string with the Eui64 of your gateway)

Topic: gw/<eui64 id>/commands

Payload:

{

"commands": [ {

"command" :

"plugin network-creator start 1",
"postDelayMs":0

1]

}

9. Program a install code string following the steps in section 7.1 of https://github.com/MarkDing/loT-Developer-Boot-
Camp/wiki/Zigbee-Hands-on-Forming-and-Joining . After that, derive a link key from the install code with the pro-
vided tool HashingTool.exe.
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4 InstallCode Hashing Tool >

InstallCode (>=6 Bytes) [1111233445566??88 j

Derived Link Key 416 18FCOCE3B0E 1445899548 16E31466 I

| Derive I

Figure 18 derive link key from install code

10. Use the following command to open network for the light:

Topic: (You need to replace the red string with the Eui64 of your gateway)

Topic: gw/<eui64 id>/commands

Payload: (The red string is the Eui64 of the light. The blue string is the derived link key)

{

"commands": [ {

"command" :

" plugin network-creator-security open-with-key {000BS57FFFEA8EF42}
{41618FCOC83BOE14A589954B16E31466}",

"postDelayMs":0

H

}

11. Run the following command on the console of the light to start joining:

plugin network-steering start 0

12. When the light joined the network, you should be able to see some messages on the subscribed topic “gw/<eui64_id>/de-
vicejoined” :

Rev.1.0 |18
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il

{"nodeld™"0x3A66" "deviceState" 16, "device Type""0x0101" "timeSincelast
Message" 3663568, "deviceEndpoint” {"eui64":"0x000B57FFFEABEFR42" "2
ndpoint™: 1, "clusterinfo”: [{"clusterld™:"0x0000" "clusterType":"In"} {"clusterl
d""0x0003" "clusterType""In"} {"clusterld":"0x0004" "clusterType""In"} {"clu
sterld""0x0005" "clusterType":"In"} {"clusterld":"0x0006" "clusterType":"In"},
{"clusterld":"0x0008" "clusterType":"In"H}}

gos : 0, retain : false, emd : publish, dup : false, topic - gw/000B57FFFEABEF3C/d
evicejoined, messageld : . length © 452, Raw payload : 123341101111001017310
0345834481205165545434443410010111810599101831169711610134584954443410
0101118105991018412111210134583448120484594849344434116105109101831
0510991017697 115 1M67710111511597103101345851545451535456443410010
111810599101659110100 112 111105110116 345812334101117 10554 52345834481
2048484866535570707069655669705250344434101110100112111105110116345849
4434908 M T M5 TIE101 114730102111 3458911 233499108 MM T M5 1R 101114 7310
Figure 19 Message on subscribed topic

13. Use the following command to control the light. The LEDO should toggle after you run this command.

Topic: (You need to replace the red string with the Eui64 of your gateway)

Topic: gw/<eui64 id>/commands

Payload: (here the 000B57FFFEA8EF42 is the Eui64 of the light. You need to modify it according to your environment.)

{

"commands": [

{

"command" :

"zcl on-off toggle",
"postDelayMs":0

}s

{

"command" :

Plugin device-table send {000B57FFFEA8EF42} 1",
"postDelayMs" :0

t

1

t
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